The TYPEQUICK No Risk Guarantee

If within 30 days of purchase, and after completing all TYPEQUICK lessons, you have not improved your keyboard skills then simply return the TYPEQUICK materials, a printed copy of the TYPEQUICK statement of proficiency, your purchase receipt and the reasons for your dissatisfaction to Typequick. We will give you a full refund or any PC touch typing program priced up to twice the cost of the TYPEQUICK course.

Typequick programs are not sold. You have paid a licence fee to use the course under the licence conditions outlined on page 43 of this guide.

Designed and developed by Typequick Pty Limited

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording or otherwise, without the prior written consent of Typequick Pty Limited. Typequick assumes no responsibility for any injury and/or damage to persons or property as a matter of products liability, negligence or otherwise, or from any use or operation of any methods, products, instructions or ideas contained in the material in this document.
Table of Contents

Introduction to TYPEQUICK  Inside Front Cover
- About TYPEQUICK  5
  - Good Typing Techniques  6
  - System Requirements  7
  - TQAdmin  8
  - Some Learning Tips  9
- Installing the TYPEQUICK Software (CD Version)  11
- Starting TYPEQUICK (CD Version)  13
  - Licence Key  14
  - Using TYPEQUICK in Evaluation Mode  15
  - Login  16
  - Getting Started  17
  - Setting Goals  17
- Starting TYPEQUICK (USB Version)  18
  - Login  19
  - Getting Started  20
  - Setting Goals  20
- Stopping TYPEQUICK (USB Version)  21
- Synchronizing a TYPEQUICK USB Drive  22
- TYPEQUICK ONLINE  24
  - Subscriptions  24
  - System Requirements  24
  - Operating Systems Supported  24
- Creating Custom Courses  25
  - Managing the course content  25
  - Updating the TYPEQUICK resources and restarting the TYPEQUICK server  29
- Troubleshooting  31
  - Online Help Files  31
  - Typequick Website  31
  - Technical Support  31

- Maintaining your Skills  32
  - Using your Skills in Documents  32
  - Resumés/Curriculum Vitae  33
  - Formal Reports and Research Papers  37
  - Bibliography/Referencing  39
- The TYPEQUICK Learn in 2 Days Plan  40
  - Before Starting  41
  - The Plan  42
- Software Licence Agreement  44

TYPEQUICK For Students
- Welcome to the Adventure  45
- Main Menu  46
  - Starting and Stopping TYPEQUICK  47
  - Progress Reports  47
  - Settings  50
  - Using the Menus  51
- Course Descriptions  53
  - Guided Tour of the Journey  55
  - Keyboard Adventure Map  56
  - Finding the Keys  57
  - Royal Challenges  62
  - Punctuation Course  63
  - The Planets Course  64
  - Australian Animals Course  64
  - Metals Course  65
  - The Senses Course  65
  - Mouse Course  66
- How to do the Lessons  67
  - Information Line  67
  - Copy the Line Presented  68
  - Timeout  68
About TYPEQUICK

- TYPEQUICK’s lessons are carefully planned and logically structured.
- Each lesson builds on the skills learned in previous lessons with the option to repeat any lesson.
- Lessons are divided into parts and each part concludes by giving you a detailed report of your progress.
- Most exercises are modelled on English sentences and words. Occasional random letter drills are designed to help you develop concentration.
- Personal encouragement motivates you to continue to achieve each progressive objective.
- TYPEQUICK alternates between speed and accuracy lessons to improve your skill in both areas.
- The friendly TYPEQUICK instructor reinforces, encourages and patiently helps with any difficulties, providing extra exercises to eliminate weaknesses. It creates a unique course for you, based on your strengths and weaknesses.
- The course is based on the latest teaching techniques and uses computer-aided instruction (CAI).
- TYPEQUICK monitors the speed and accuracy of every keystroke and the hesitancy between keystrokes, then tailors the course material accordingly so that you learn at your maximum learning rate.
- The uncluttered, clear screen layout allows you to focus on the line to be typed.
- TYPEQUICK is quick! There are no unnecessary graphics, games and music to slow the program down. Often these elements are a distraction and do not increase retention or reduce the learning period.
Good Typing Techniques

Posture is important. Sit with your back straight, in a comfortable position with both your feet flat on the floor. Your elbows should be slightly ahead of the side of your body when your curved fingers are on the home row. The home row keys consist of the letters a s d f and j k l ;. Keep your elbows close to your side and your wrists straight.

Fingers must be curved as they would be when your arm is loosely hanging by your side. Press the keys smartly and firmly with the tip of the appropriate finger.

Your fingers should hover over the home row keys, lightly touching the tops of the keys. Anchor at least one finger on its home row key, usually the 'a' or the ':' (semicolon) key, when typing keys in other rows. Always return your fingers to the home row.

Research indicates that you should force yourself to maintain a fast, comfortable pace and tolerate a few errors. Later you should practise your accuracy at an increased speed, keeping in mind the following:

- Avoid hesitation. Concentrate on speed rather than accuracy. TYPEQUICK’s remediation will automatically correct your accuracy.
- Only move your fingers – do not bounce your hands and arms up and down.
- Strike the keys using an even rhythm.
- Adopt the correct posture.
- Relax your muscles.
- Take a short break every 15 minutes or whenever you feel muscle cramps or aches.

System Requirements

Hardware Requirements:
- 750MHz or higher
- 256MB RAM
- 640x480 display at 16-bit colour
- Video card - any
- Sound card - any
- CD Version - CD Drive required during installation only
- USB Version - requires USB 2.0 support

Operating System Requirements:
Apple Mac: Mac OS X with Java 1.4.0 or higher
Other: Linux (Intel PC)

File Sizes

The table below indicates approximate space requirements for the following components:

<table>
<thead>
<tr>
<th>Component</th>
<th>Space Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java Runtime</td>
<td>55MB</td>
</tr>
<tr>
<td>TQClient Program</td>
<td>6MB</td>
</tr>
<tr>
<td>TQAdmin Program</td>
<td>6MB</td>
</tr>
<tr>
<td>TQServer Program</td>
<td>6MB</td>
</tr>
<tr>
<td>Typequick Professional Resources</td>
<td>30MB</td>
</tr>
<tr>
<td>Typequick for Students Resources</td>
<td>350MB</td>
</tr>
<tr>
<td>SKE Resources</td>
<td>6MB</td>
</tr>
</tbody>
</table>
The TQServer program creates and maintains a database which will grow from an initial size of approximately 1MB to a size dependent on the number of students using the TYPEQUICK application and the number of lessons attempted.

Java 1.4.2 (or Java 1.6) is shipped with the TYPEQUICK program so users will not have to download or purchase additional software to run TYPEQUICK on most platforms. However, on Mac OS X (which always has Java runtime installed by default), users must have applied the necessary updates to their Java runtime so that their installed version is at least 1.4.0.

Some Learning Tips

Before you start, here are a few tips to help you:

- Make a personal commitment to achieve a specific goal – say conservatively 25 words a minute with 95% accuracy.
- Repeat your goal to yourself every day and make it a part of your daily routine.
- Tell a friend who will encourage you and monitor your progress.
- Visualise yourself touch typing.
- Set aside one hour a day for the next ten days and schedule it in your diary.
- Make the commitment.
- Mental practise is important. Use free moments during the day to mentally rehearse the typing of the keys you have learned.
- You will learn more quickly if you read and follow the appropriate sections in this manual.
- Resist the temptation to use the wrong fingers. Use the correct finger for each key as shown in the course.
- Say the letters out loud as you press the keys. Using all your senses will help you to learn faster.
- Complete each part of the lesson you commence, otherwise you will need to restart that lesson part.
- Repeat the lessons that teach your weak keys if you need extra practise.
- Only do the speed and accuracy courses after you have learned the whole keyboard or keypad.
- Reassess your goal speed after each course. Always set your goal speed to 20% above your average speed, that way you will always be pushing yourself to improve.
- Do not do the Keyboard Lessons and Keypad Lessons at the same time. It might be confusing.
- You must finish all ten lessons of the Keyboard Lessons course, and achieve a speed of 25 WPM, to make the course worthwhile.
- Promise yourself to never go back to two-finger typing.
- Test yourself regularly and continue to improve.
Learning Tips (continued)

The best way to learn is to do this course in a short time – ideally an hour a day for ten days.

However, if you want to progress quickly Typequick offers a two-day plan. This is an intensive course for goal-driven achievers based on five hours a day over two days. It has been designed for those who want to type properly but want to learn quickly because they have limited time. The two-day course is explained in detail later.

We recommend that you repeat a lesson every so often while continuing with the course. Keep moving through the course, don’t get stuck continually repeating lessons.

<table>
<thead>
<tr>
<th>REWARD CHART</th>
<th>TARGET</th>
<th>ACHIEVEMENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>ULTIMATE GOAL:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reward:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SUB GOAL 1:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reward:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SUB GOAL 2:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reward:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SUB GOAL 3:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reward:</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Installing the TYPEQUICK Software (CD Version)

Windows Users

When the CD is inserted in the target machine’s CD drive, the install program should start automatically. If it does not, use Windows Explorer to view the contents of the CD and then double click on the Setup.exe program that is in the root folder of the CD.

1. The Installation window opens. You are prompted to confirm the installation. Click the “Install” button.

2. The Introduction panel displays general information on how to use the installation. You can launch the Installation Help to assist you in installing TYPEQUICK whether it be on a single workstation, network or web server. Click the “Next” button to continue.

   Note: The Help window may obscure the installer window. To continue the installation process, you may need to redisplay the installer window.

3. The Licence Agreement panel displays. When you have read the licence agreement and agreed to it, click to select the radio button next to “I accept the terms of the Licence Agreement”. You will then be allowed to click the “Next” button.

4. Read the information on each panel and make selections as relevant, then click the “Next” button to proceed.

   Note: To ensure correct installation of TYPEQUICK, it is important to read each panel and follow the instructions before clicking the "Next" button. You may return to a panel screen at any time by clicking the "Previous" button, or cancel the installation by clicking the "Cancel" button.

5. When you have completed the installation panels, click the “Install” button. TYPEQUICK will install using the settings you have selected.

6. When the installation is completed, and the check box “Launch the program” is checked, click the “Done” button. The installation window will close and TYPEQUICK will launch automatically.
Mac Users

1. Insert the CD.
2. Double click on the CD icon on your desktop.
3. Select the MacOSX folder.
4. Double click on the Disk1 folder, then the InstData folder then the MacOSX folder and finally on the Typequick icon (blue TQ icon).
5. The Typequick Install program will start.
6. Follow the prompts as for Windows users.

Linux Users and Unix Variants Users

1. Insert the CD.
2. Browse the CD contents with a file manager program.
3. Double click on the Disk1 folder, then the InstData folder.
4. Find the folder which matches your PC's OS-hardware combination and double click on the folder (eg. Linux-Intel).
5. Double click on the VM folder.
6. Double click on the Typequick installation application.
7. Follow the prompts as for Windows users.

If your operating system or hardware does not meet the minimum system requirements as outlined, this version of TYPEQUICK will not run or will run very poorly. It may still be possible to run TQClient on this machine via a browser provided a TQServer can be established on another machine on your network. Refer to Installation Help.

Displaying Installation Help

Installation Help provides background on the installer as you go through the installation process. Information is also included on issues that may need to be addressed after installation has completed.

To redisplay the Help information after installation has been completed, open the TQInstallHelp file. This is stored in the same location as the TYPEQUICK installation.

Starting TYPEQUICK (CD Version)

This section describes the procedure for starting the version of TYPEQUICK that is installed from a CD (compact disc) or from a downloaded installation file.

To start the TYPEQUICK program, click on the TYPEQUICK icon for the program you have purchased. The location of the icon will depend on where it has been installed, for example on the desktop or in a program group.

The following describes how to start TYPEQUICK for a Windows user when it has been installed with all the default settings. If the default settings were not installed, the method used to start a TYPEQUICK product may be different.

1. Double click the TYPEQUICK icon on your desktop for the program you have purchased.

The first TYPEQUICK page opens and several messages display in the bottom left-hand corner. You will be prompted to log in.

Cancelling the Server Connection

If, after a minute or so, the Login dialog box does NOT display, and TYPEQUICK does not connect to the server, click the "Cancel" button in the bottom right-hand corner of the screen. You can then restart the program and try again.
**Licence Key**

To run any programs or courses you are required to enter an authentic TYPEQUICK licence key. You should have received this licence key when you purchased TYPEQUICK.

The first time you run any program, you will be asked to enter a licence key. The following prompt will display.

1. Click the "Yes" button.
2. The Add a Licence dialog box displays.

3. Enter the licence key. Remember to add it exactly as it is written, using capital letters and dashes (-) as required. Click the "Add a Licence" button to submit the licence you have typed. The licence is checked. If the key is active the Add a Licence dialog box will close. If the key is not active you will be led through a process to activate your licence key.

Clicking the "Purchase a Licence" button on the Add a Licence dialog box will display the Typequick website page from which you can purchase a licence. You must have a connection to the Internet to use this option. If you do not have Internet access refer to Contact Typequick to purchase a licence key.

**Using TYPEQUICK in Evaluation Mode**

If you click the "No" button when prompted "Do you have a licence key that can be added?" TYPEQUICK will start and run in Evaluation Mode. This allows you to evaluate the product, review its features and the layout of the screens.

Only the first three lesson parts of the Keyboard Lessons course are available in evaluation mode. These are:

- **Introduction - Posture Information.** This provides information on why posture is important and how to adopt the correct posture while typing.
- **Introduction - Home Keys.** This lesson introduces the home row keys.
- **Lesson 1 - Part A.** This teaches the use of the first home row keys, the letters 'a', 's', 'd', 'f' and the 'spacebar'.

No other lessons within the Keyboard Lessons course are available nor are any of the other courses. If you try to run a lesson that is not part of the evaluation the following message displays.

![Evaluation Mode Message]

The results from the lessons are saved in the database, so when you do enter an active licence key you can move directly on to Lesson 1 - Part B.

**Purchasing a Licence Key**

To purchase a licence key to activate the program visit our website www.typequick.com.au If you do not have Internet access contact TYPEQUICK direct. Typequick Contact Details can be found inside the back cover.
Adding a Licence

In Evaluation Mode there are two ways in which you can add a Licence:

- Every time you start TYPEQUICK you will be asked if you have a licence to add. To add a licence, click the "Yes" button to display the Add a Licence dialog box.
- Start TYPEQUICK, select Add Licence from the File menu and the Add a Licence dialog box displays.

Enter the licence key (refer to Licence Keys).

Login

Each time you use TYPEQUICK, you will be asked to enter your Login Name. The default is to allow you to set up your own Login Name. There is no Password required. There are other ways in which the login can be set up and these are described in the Program Help by clicking the Help menu at the top of the screen.

Setting Up Your Login Name

To set up your Login Name from the Login dialog box, click the "New Student" button. The Add a Student dialog box displays.

1. Enter the Login Name you want to use, usually your initials or your first name only.
2. Enter your Full Name and click the "OK" button. The Login dialog box redisplays. The Login Name you entered for the new student is automatically added to the Login dialog box.
3. Click the "OK" button to start using TYPEQUICK.

Note: Your Login Name is NOT case sensitive.

Forgotten Login Name or Password

If you forget your Login Name you can view it in the TQAdmin program. If you forget your Password, it can be changed in the TQAdmin program. For more information refer to the TQAdmin Help program located in the folder where TYPEQUICK is installed.

Getting Started

When you first start TYPEQUICK, the Main Menu displays. To start at the beginning of the course, all you need to do is click Start Course.

TYPEQUICK automatically starts with the Introduction to the course.

Setting Goals

TYPEQUICK has set a default goal speed of 25 words per minute. This speed is a realistic goal for someone who is familiar with the computer keyboard and is learning touch typing skills. The goal speed is used by TYPEQUICK to offer meaningful motivational messages.

If you are new to computers and touch typing we suggest you change the goal speed to 20 words per minute.

If, however, you are using TYPEQUICK to improve existing keyboard skills the goal speed should be increased according to your level of expertise and keyboard usage.

When altering your typing goal speed keep in mind the following:

- Most people write at a speed of 15 words per minute.
- Many organisations set a minimum standard of 30 words per minute with 95% accuracy.
- Initially typing speeds drop considerably while you learn new keys and to touch type with ten fingers.
- A professional typist types at 60 to 80 words per minute.
Starting TYPEQUICK (USB Version)

The USB version of TYPEQUICK does not require installation to the hard drive. This means that you can take the TYPEQUICK USB/Flash Memory drive from one computer to another and use it without making any changes to the computer (assuming the computer supports USB 2.0). Also, using the TYPEQUICK USB drive does not leave anything on the computer; all your results are kept on the TYPEQUICK USB drive.

To start the TYPEQUICK program, just plug the TYPEQUICK USB drive into a USB 2.0 socket on the computer.

On some systems, when you insert the TYPEQUICK USB drive into a USB socket, the computer system will detect it and ask you if you want to run the program from the drive. If your system does not automatically start the TYPEQUICK program you will need to use the computer system to find the program on the TYPEQUICK USB Drive and manually start the program.

Follow the instructions below for your operating system if the TYPEQUICK program does not start automatically:

Windows
Open a Windows Explorer window on the TYPEQUICK USB Drive and find the program Windows_Typequick_Professional or Windows_Typequick_for_Students and double click it to start the program.

Apple OSX
Double click on the "TYPEQUICK" icon on the desktop to show the files on the TYPEQUICK USB Drive. Find the Typequick Professional.app (the red icon) or the Typequick for Students.app (the green icon) and double click it to start the program.

Linux
Find the shell script LinuxTypequickProfessional or LinuxTypequickForStudents on the TYPEQUICK USB Drive, right click on the appropriate file and choose "Other". When a dialog box pops up to allow you to choose the program, to run the LinuxTypequickProfessional or LinuxTypequickForStudents script file, type in "sh" and choose OK. The LinuxTypequickProfessional or LinuxTypequickForStudents program should start. It may be possible to just click on the shell script depending on the Linux system.

Login
Each time you use TYPEQUICK you will be asked to enter your Login Name. The default is to allow you to set up your own Login Name. There is no Password required. The login can be set up differently as described below.

Setting Up Your Login Name
To set up your Login Name from the Login dialog box, click the "New Student" button. The Add a Student dialog box displays.

1. Enter the Login Name you want to use, usually your initials or your first name only.
2. Enter your Full Name and click the "OK" button. The Login dialog box redispersals. The Login Name you entered for the new student is automatically added to the Login dialog box.
3. Click the "OK" button to start using TYPEQUICK.
   Note: Your Login Name is NOT case sensitive.

Forgotten Login Name or Password
If you forget your Login Name you can view it in the TQAdmin program. If you forget your Password, it can be changed in the TQAdmin program. For more information refer to the TQAdmin Help program which is located in the root directory of the TYPEQUICK USB Drive.
**Getting Started**

When you first start TYPEQUICK, the Main Menu displays. To start at the beginning of the course, all you need to do is click Start Course.

TYPEQUICK automatically starts with the Introduction to the course.

**Setting Goals**

TYPEQUICK has set a default goal speed of 25 words per minute. This speed is a realistic goal for someone who is familiar with the computer keyboard and is learning touch typing skills. This goal speed is used by TYPEQUICK to offer meaningful motivational messages.

If you are new to computers and touch typing we suggest you change the goal speed to 20 words per minute.

If, however, you are using TYPEQUICK to improve existing keyboard skills the goal speed should be increased according to your level of expertise and keyboard usage.

When altering your typing goal speed keep in mind the following:

- Most people write at a speed of 15 words per minute.
- Many organisations set a minimum standard of 30 words per minute with 95% accuracy.
- Initially typing speeds drop considerably while you while you learn new keys and to touch type with ten fingers.
- A professional typist types at 60 to 80 words per minute.

**Stopping TYPEQUICK (USB Version)**

NEVER just remove the USB/Flash Memory drive from the USB socket! Make sure you follow the Safely Remove Hardware procedure as described below before physically removing the USB drive from the USB socket on the computer.

If you don’t instruct the computer system to safely remove the USB drive first, you may cause the TYPEQUICK database on the USB drive to become corrupted. If an error message appears or the USB drive will not start you should contact TYPEQUICK immediately. Our contact details are inside the back cover.

You should never remove the USB drive while the TYPEQUICK program is still running!

Follow the USB drive safe removal instructions relevant to your operating system below:

**Windows**

Left click the mouse on the image (or ) in the system tray and a list of removal items will appear. Choose the line that contains the drive letter that corresponds to the TYPEQUICK USB Drive and wait for the "Safe to Remove Hardware" bubble to appear. Remove the TYPEQUICK USB Drive when the red light at the back of the drive is off.

**Apple OSX**

Do a "ctrl click" on the TYPEQUICK icon on the desktop and choose the "Eject TYPEQUICK" entry from the menu. The TYPEQUICK icon will disappear and the TYPEQUICK USB Drive may be removed.

**Linux**

Find the TYPEQUICK drive in the removable media, right click on the drive and choose the entry to eject the drive. When the drive disappears from the list of devices you can physically remove the TYPEQUICK USB Drive from the USB socket.
Synchronizing a TYPEQUICK USB Drive

If a person has the same Login ID on a TYPEQUICK USB Drive and on a networked version of TYPEQUICK then it is possible for that person to do the course at any time on workstations connected to the network TYPEQUICK Server or on the TYPEQUICK USB Drive.

To ensure the database on the TYPEQUICK USB Drive and on the database held by the Network TYPEQUICK Server reflect the same results, the TYPEQUICK client program provides a function to synchronize the two databases.

The synchronization function is accessed from the File menu when running the TYPEQUICK client program from the TYPEQUICK USB Drive. The following dialog box is displayed:

To carry out the synchronization operation, the TYPEQUICK client program needs to know the IP address and the port number being used by the Network TYPEQUICK Server. The Network Administrator should be able to provide the required information (the image above is only an example).

The TYPEQUICK program on the TYPEQUICK USB Drive will exchange results with the Network TYPEQUICK Server so that both databases show the most recent lesson results.

For instance, if a student does lesson 1a on the TYPEQUICK USB Drive and lesson 1b using a workstation connected to the Network TYPEQUICK Server, then a synchronization operation will result in the databases having the results for both lessons 1a and 1b.

If a student does lesson 1c on the TYPEQUICK USB Drive and later does lesson 1c again on a workstation connected to the Network TYPEQUICK Server, then a synchronization operation would leave the database on the Network TYPEQUICK Server unchanged, but replace the older lesson 1c results on the TYPEQUICK USB Drive by the latest results from the Network TYPEQUICK Server.

Once the IP address details are entered, click on the "Synchronize Now" button.
TYPEQUICK ONLINE

TYPEQUICK has released an online web version which allows anywhere, anytime keyboard training. All you need is access to a computer with a broadband internet connection and supported browser. No installation and no licence keys are required.

Subscriptions

To access the TYPEQUICK Online Web Version, users purchase a subscription for one person for a period, ranging from 6 to 12 months, depending on how much training is required. The subscription may be extended at the end of the period.

System Requirements

- Internet broadband connection with minimum speed of 512 kbs
- Browser versions Microsoft Internet Explorer 6.0 or later, Firefox 2 or later, Opera 9.5 or later, Safari 3 or later, Chrome 2 or later, SeaMonkey 1.11 or later
- Adobe Flash Player 10 or higher must be installed
- Javascript must be enabled on the web browser

Operating Systems Supported

- Windows 7, Vista, XP and 2000
- MAC OS X v10.4 or later
- Red Hat® Enterprise Linux (RHEL) 5, openSUSE® 11, Ubuntu 7.10 or later or 8.04 or later

Creating Custom Courses

The TQAdmin program enables administrators to create, amend, replace or delete additional courses using customised lesson text. Each course is made up of one or more lessons and each lesson requires its own lesson text file. The program can be used to add new text for students to practise or to add text relevant to a specific business or educational curriculum.

IMPORTANT: Creating and adding courses must be done on the server. Once a new course is created or changed the ‘Resources’ folder that contains the files with the new course material must be copied to the same location at each workstation. The default location of this folder is C:/Program Files/Typequick/Resources. See ‘Updating the Typequick Resources’ at the end of this section.

Managing the Course Content

Creating Lesson Text Files

1. Create new text files - Open a new document using any word processing program. Text may be cut and pasted into the document or typed in, but each line must contain no more than 56 characters. At the end of each line (56 characters only) hit Enter to create a hard return to the next line (don’t rely on the editing program to wrap the lines). The file must now be named and saved.

2. Naming the new text files - Once a new lesson text file has been completed, it must be named in a specific format so that the Typequick program can recognize the new lesson. The format is as follows:

Lesson type-lesson name-lesson number.txt

- **Lesson type**: the Lesson type must be either Speed or Accuracy. An upper case S or A must be used. A custom course can include Speed lessons or Accuracy lessons or a combination of both.
- **lesson name**: the lesson name will appear in the ‘Lesson Selector’ window (at the Typequick Main Menu select Choose Course then highlight the custom course required and click ok) of the custom course. Lesson names should not contain any non alpha-numeric
characters other than spaces, apostrophes and parentheses. It is recommended that lesson names not be re-used.

**lesson number**: the lesson number identifies where the lesson appears in the course. The lesson number must contain 2 digits and can be any number between 01 and 99. Lesson numbers must not be repeated within a course. Where courses contain both Speed and Accuracy lessons care must be taken not to use the same number. The numbers don’t need to be consecutive.

Examples of properly constructed file names are listed below:
- Speed-ScientificInstruments-01.txt
- Speed-RadioBroadcasting-02.txt
- Accuracy-RadioBroadcasting-03.txt

### 3. Saving the new text files

Once the text file name is correctly formatted it must be saved as a plain text file. For example, if you have created the text file using Microsoft Word we suggest it be saved as an ‘**MS-DOS Text**’ file. Click the drop down arrow in the ‘save as type’ field and scroll down the list until ‘**MS-DOS Text**’ is highlighted then left click. Click the ‘Save’ button to save the file. Files saved as ‘.doc’ files will not be recognised.

**NOTE:** We suggest you create and name a new folder for each course, where you can save all the new Lesson Text Files for example, ‘Course One Text’ or ‘Course Two Text’. Make a note of the location of the folder where the new Lesson Text Files have been saved.

A ‘Speed’ lesson is one where students’ keystrokes are not required by the program to match the text. In ‘Speed’ lessons, the line below the copy text typed by the student is shown as blank when the student types the correct key and in red when the incorrect key is typed. For an example of a ‘Speed’ lesson refer to the Typequick course ‘Speed Challenge’.

In ‘Accuracy’ lessons incorrect keystrokes do not advance the cursor although the program will still track the number of errors. For an example of an ‘Accuracy’ lesson refer to the Typequick course ‘Accuracy Challenge’.

Once the Lesson Text Files have been created, named and saved the next step is ‘Creating a Course’.

### Creating a Course

1. **Opening the ‘Custom Text Course Generator’** - To create and add a course that uses the customised lesson text files double click the ‘TQAdmin’ icon on the desktop to open the TQAdmin program. When prompted for a login type ‘administrator’ and click ‘ok’. The TQAdmin program window will open. On the toolbar click ‘Actions’ then scroll down and left click on ‘Custom Courses’. A dialog box will appear:

   ![Custom Text Course Generator](image)

   It is recommended that you record the codes, folders and names used to create each course. These details will need to be entered if you wish to change or remove a course at a later date.

   **NOTE:** Details of any existing Custom Courses will be shown. The Title field has a drop down menu which can be used to find an existing Custom Course. Once a title is selected the corresponding 3 letter code and Location name will be listed in those fields.
2. ‘Title’ field - At the top left corner of the window is the ‘Title’ field. Enter the name of the course as you want it to appear in the Choose Course Menu in the Typequick program. The course name may contain alphanumeric characters, spaces, apostrophes and parentheses but no other special characters. You may wish to use your School, College or Company name in the course name.

3. ‘3 Letter Code’ field - To the right of the Title field, you must assign a 3 letter code and enter it in the ‘3 Letter Code’ field. This code is used as a short hand reference internally by the Typequick program. If multiple courses are being created, each course must have a unique 3 letter code. The following codes must not be used as they are already used in the Typequick program: ACH, ADC, KBD, SCH, PUN, KPD, RYC, RY2. The code must be entered in uppercase. You should record the 3 letter code given to each course separately.

4. ‘Location’ field - To the right of the 3 Letter code field the ‘Location’ field requires you to enter a folder name. A new folder of this name will be placed in the Resources area of the Typequick program files and the custom course content will be stored in it. You should record the folder name used for each course.

5. ‘Course Text Folder Location’ field - Below the Title field, the ‘Course Text Folder Location’ section of the dialog box requires you to find the folder containing the Lesson Text Files created in step 1 for each course. Browse the directories until the folder name appears in the ‘Look In’ field. All ‘Lesson Text Files’ in this folder will now be listed in the main field. All files beginning with Speed or Accuracy, with a correctly formatted name, will be used to create the new course. The file name does not need to be listed in the File Name field.

6. ‘Generate Course’ button - Once the correct folder is identified in the Course Text Folder Location field the course can be generated by clicking the ‘Generate Course’ button. A message will appear in the ‘Results from Course Generation’ field confirming the Course creation.

Click the Exit button to close the ‘Custom Text Course Generator’ window and go to ‘Updating the Typequick resources and restarting the TQ server’ at the end of this section.

Correcting or Changing Courses

Using the ‘Custom Text Course Generator’ you can amend, add or remove lessons from any of your custom courses. Only courses that have been added via the ‘Custom Text Course Generator’ can be changed.

1. Changing the Lesson Text Files - Open the folder that contains the saved Lesson Text Files. You can add new lesson text files, adjust the text in any of the existing files or delete lesson text files that are no longer required. After saving new files or changes to any existing files open the ‘Custom Text Course Generator’ (see Creating a Course - 1. Opening the ‘Custom Text Course Generator’).

2. Adding the changed Lesson Text Files - Using the drop down menu in the Title field, browse the list of existing Custom courses and click on the course where the lesson text files are to be amended. The 3 letter code and the Location field will be filled in automatically with the corresponding course details. Browse the directories until the name of the folder that contains the amended lesson text files appears in the ‘Look In’ field and the lesson text file names appear in the main field. The selected course will be updated to include only the lesson text files listed. Any lesson text files previously included in the course that are not listed will be deleted.

3. Generate Course - You can now press ‘Generate Course’. A message will appear in the ‘Results from Course Generation’ field confirming the changes to the course.

The changes will not affect any existing student data related to the course unless the lessons are renumbered.

Click the Exit button to close the ‘Custom Text Course Generator’ window and go to ‘Updating the Typequick resources and restarting the TQ server’ at the end of this section.

Removing Custom Courses

Courses may be removed if they are no longer required or if a major error occurred while a course was being added.

Open the ‘Custom Text Course Generator’ (see Creating a Course - 1. Opening the ‘Custom Text Course Generator’).
Using the drop down menu in the Title field, browse the list of existing Custom courses and click on the course that you wish to remove. The 3 letter code and the Location field will automatically be filled in with the correct details. The Custom Course and all the lessons contained within it will be removed from the Typequick program. Click the ‘Remove Course’ button. A message will appear in the ‘Results from Course Generation’ field confirming the Course deletion. Click the Exit button to close the ‘Custom Text Course Generator’ window and go to ‘Updating the Typequick resources and restarting the TQ server’ at the end of this section.

Updating the Typequick resources and restarting the TQ server

Before the new course material will be available the Typequick files must be updated and the TQ server restarted.

- Close ‘TQAdmin’ and the Typequick service.
- Find the Typequick ‘resources’ folder. The default location of this folder is C:/Program Files/Typequick/Resources. The ‘resources’ folder contains the new material and must be copied to the same location at each workstation for the new material to be available.
- Copy this folder from the server and overwrite the folder on each workstation.
- Restart the Typequick service.

The Choose Course menu in the Typequick program will be updated once Typequick is restarted.

For web-browser installations the resources folder that the workstations use will be located on the server.

Running the Custom Course

The new course can be found by selecting ‘Choose a Course’ from the Typequick Main Menu and highlighting the course name. Click ‘OK’ and a list of all the custom Lessons will appear. Highlight the required lesson and click ‘OK’. The lesson will begin.

Troubleshooting

Online Help files

There are three comprehensive help files associated with this program that will help explain or troubleshoot any problems that may arise.

Install Help
This file describes the installation procedures for various computer and network configurations.

TQAdmin Help
This file describes the options and elements of the TQAdmin program.

Program Help
This file describes the elements of the Typequick course.

Typequick Website

From the Help menu you can access the Typequick website. The Typequick website where you can find a list of Frequently Asked Questions. Our website address is www.typequick.com.au

You can also contact us through our email: support@typequick.com.au

Technical Support

Typequick provides free technical support. Please provide the following in any correspondence:

- your 20 digit licence key.
- a detailed description to the problem you have encountered.
- the exact error message that appears on your screen.
- details of your PC and operating system.
Maintaining Your Skills

Not everyone has the opportunity to use their keyboard skills on a regular basis. Some people type a lot more than others either at work or school. If you don't get the opportunity to type much, don't waste the time investment you have just made gaining valuable keyboard skills by letting them slip away - make sure you practise regularly.

You can do additional courses like Speed Builder or Advanced course as often as you like. Or you could choose a piece of text from a magazine on a topic that interests you and practise by copy typing it – a great way to put into practice everything you have learned, as well as maintaining your speed and accuracy.

As in all things, the harder you practise the better you become.

Using your Skills in Documents

Now that you have learned to touch type you will be keen to use this valuable skill to produce documents on your computer.

We have listed several common standards and model document formats and styles which you may use when preparing letters, resumés and bibliographies.

Note: Remain consistent in format and style throughout a single document.
Don't complicate your document with too many different fonts, headings and other styles.

Resumés/Curriculum Vitae

Your resumé or CV (curriculum vitae), is one of the most important documents you will ever write. It is your first introduction to prospective employers and can say much about you from the way it is written, its design and layout and the information you include. The most important thing to remember when writing your resumé is that in most cases, 'less is best'!

The aim of your resumé is for it to be read and for you to consequently secure an interview. A cluttered, busy looking resume will be put aside while a clear and succinct resumé will be favourably considered.

Keep the design and layout simple. Use a clear, modern font such as Arial or Tahoma. Do not use elaborate fonts like Comic Sans Serif as they are much more difficult to read and not professional. These fonts are best kept for party invitations and the like!

Choose your font size according to the font type you use and the amount of text you have. If you are using Arial or Tahoma, 11 points is a good size for text with 12 to 14 points for headings. Times New Roman is a smaller font, so you would need to use 12 points for text and 14 for headings.

Use italics sparingly – heavy use of italics makes a document very difficult to read. You can use bolded text a little more, but usually only for headings and not for full sentences. Make sure you leave lots of white space on the page as it makes a document much easier to read. It also helps the reader make notes or comments.

Colour is not important in a resumé. It is better to use black text only because many colours are not as visible when printed or when viewed on screen in an email. Using a dark blue for headings is acceptable, but colours like yellow and light green are very difficult to see and are best avoided.

There are many different ways you can set out your resumé and we have included one example for you to have a look at. The information you include is up to you, but there are some definite do's and don'ts. You should include the following:

- Your personal details (including contact details)
- Your education details and qualifications (in date order listing most recent first)
- A skills and strengths summary
- Your computer skills
- Your references
If you want to be contacted by email, make sure your email address is correct and active and is professional. Not many employers would be inspired to reply to an email address like funnydave@australiail.com or greatbluke@australiail.com! Try something like johnsmith@australiail.com or jsmith@australiail.com

It is not necessary to include the following details, but you may do so if you feel it is important:

- Age
- Nationality (you may include this if most of your work experience is overseas)
- Marital status and number of children (not recommended unless relevant to the position you are applying for)
- Photo (not recommended unless relevant to the position you are applying for or specifically requested)

When listing your work experience, always start with your most recent job and work back. List your employers’ names and give a brief summary of what the company does. Give your job title, who you reported to and then detail your duties.

You may want to give a ‘Career Summary’ on the first page of your resumé and go into more detail on the second page. Have a look at the example we have provided for you.

It is always a good idea to include a cover letter with your resumé, especially if you are sending your resumé to companies in the hope that a position is available. Each cover letter should be written specifically for the job you are applying for, outlining the skills and attributes that you can bring to the position. If you are not applying for a specific job, you should tailor the cover letter to the company you are sending it to.

As with your resumé, your cover letter should be clear and simple, highlighting why you feel you are the right person for this position. Avoid using big words – saying something clearly and concisely has much more impact than saying the wrong thing in flowery language! Make sure you highlight all the desired qualifications and skills that were mentioned in the job ad, but remember that your cover letter should not be a re-hash of your resume. It must be a unique document that enhances your resumé and specifically targets the requirements of the position you are applying for.

---

**Curriculum Vitae - Sample**

**Personal Details**

Name: Megan (Meg) Brommley
Address: 2/44 Seaview St
Curl Curl NSW 2096
Telephone: (02) 9999 1111
0477 777 111
Email: megbrommley@hotmail.com
Date of Birth: 24 February 1972
Objective: To obtain a fulfilling career that uses my education and skills to their full potential.

**Education**

2001–Current
Masters of Commerce (Professional Accounting)
University of Sydney - part time
1992
Bachelor of Commerce (Accounting)
University of Technology Sydney (UTS)
1989
North Sydney Girls’ High School
Higher School Certificate

**Career Overview**

2000–Current
Northern Star Press
Financial Controller, NSW Division
1995 – 1999
New Horizons Broadcasting Co.
Accountant
1993 – 1995
Abercrombie & Burns Pty Ltd
Junior Accountant
**Career Details**

2000 – Current: Northern Star Press

Company Overview: A medium sized company, publishing newspapers in mainly rural areas.

Position: Financial Controller, NSW Division

Reporting to: Chief Financial Officer

Duties: Responsible for the daily management of 3 staff and supervision of 4 staff in regional offices; preparation of budgets for the NSW Division;


Company Overview: A small broadcasting company with three rural radio stations.

Position: Accountant

Reporting to: Managing Director

Duties: Responsible for all accounts and budgets


Company Overview: A small manufacturing company.

Position: Junior Accountant

Reporting to: Accountant

Duties: Responsible for all account processing

**Other Skills**

Write and speak Japanese and French

Proficient in Microsoft Word, Excel, Publisher

Proficient in MYOB Business

**Interests**

Skiing, Music, travel, community work, triathlons

**References**

Mr J D Palmer, CEO Northern Star Press Polding St, West Ryde 2114 Tel: (02) 9835-6048

Ms Francis Reading (Chairman) EL Financial Group 211 Macquarie St, Sydney 2000 Tel: (02) 9259 3333

---

**Formal Reports and Research Papers**

A formal report or research paper is a detailed document of facts, opinions, recommendations and conclusions on a specific topic. There is a generally accepted format for these documents, as recommended by the American Psychological Association (APA), and that is what the following example is based on.

Your document should have margins of 2.5 cm all round. Double line spacing should be used throughout the document and a single space should be used at the end of each sentence within a paragraph. Each paragraph should have a first line indent of about 1.2 cm and be left aligned. Do not justify the text and do not hyphenate words at the end of a line.

If your report is very long, you may want to include a Table of Contents and an Index. Always include relevant footnotes; a list of tables, diagrams and drawings; any appendices; and a complete Reference (Bibliography) of sources used in your report.

You can reference throughout your document in brackets directly after the quote in the body of the text (also known as parenthetical citation), or by using footnotes (numbering and referencing by number at the bottom left of the page). If you reference using footnotes, separate them from the main document with a line above. Whichever style you prefer, choose one and stick with it!

Consistent use of formatting applies wherever you have an option, including the spelling you use (Australian English, UK English, or US English). These days it is quite acceptable to use US English in your documents, but do not mix it with Australian or UK English. For example, do not use ‘maximise’ and ‘colour’. You should use either: ‘maximize’ and ‘color’ OR ‘maximise’ and ‘colour’. Quotations should be left with the spelling exactly as it is in the original document.

Your report should be set out as follows:

**Page 1: The Title Page**

This page contains the title of the paper, your name and the institution which it has been written for, if applicable. Text should be centred and double spaced. The page should be numbered as page 1. The title of your paper should appear in the top right hand corner of the page followed by the number 1. Abbreviate the title if it is very long. For example, a paper titled ‘Understanding the Migratory Habits of Wrens, in Particular Eastern Blue Wrens and Related Species’ could be abbreviated to ‘The Migratory Habits of Wrens’. (This title and page number should appear on every page of the report except for pages with diagrams.)
Page 2: The Synopsis
This page contains a brief summary of your paper, approximately 100 – 150 words long. The title of your paper should appear in the top right hand corner of the page followed by the number 2.

Page 3: The Beginning of the Paper
The title of your paper should appear in the top right hand corner of the page followed by the number 3. The full title of the paper should be under this, centred and double spaced. The actual paper starts one line (double spaced) below the title.

References
As with any document where you rely on quotations or data from other peoples’ work, you must properly reference everything you have used. A guide to referencing follows this section. Your references should be listed on a separate page at the end of your document.

Diagrams, Tables and Drawings
The generally accepted standard is for diagrams, tables and drawings each to be on a separate page at the end of your document. However, if you are submitting a work for your school, college or university, your teacher/lecturer may have specific requirements. It is worth checking with them first to make sure you format your document as required. Each diagram, table and drawing should be labelled and referred to in the text by the label, e.g. Table 1, Diagram 4.1 etc.

The Main Heading should be centred and in Title Case (CAPS at the start of each letter). Section Headings should be aligned to the left hand margin and underlined, also in Title Case. Subheadings should be indented from the left margin, underlined and in Sentence Case (capital letter on the first word only). Any further subheadings should be indented from the subheading above it.

Quotations throughout the document should be indented and contained in quotation marks. You can change the spacing for quotations from double to single, particularly if double spacing detracts from the original intent or meaning of the quote, such as with poetry.

Bibliography/Referencing
A bibliography lists alphabetically by author’s surname, the books, journals and unpublished sources used in preparing a report. The bibliography is located at the end of a report/research paper. Some educational institutions and other bodies may prefer a specific style.

Order of detail for books, articles and websites:
- Author’s surname followed by given name and/or initials
- Book/magazine title - underlined or italicised
- Volume number and or month/year of issue
- Publisher
- Place of publication
- Page number/s where article may be found

Bibliography - Sample
Bibliography

(3 line spaces)


The TYPEQUICK
Learn in 2 Days Plan

The best way to learn is to do this course in a short time – we recommend an hour a day for ten days. However, there is a proven, intensive, two-day plan. The course runs for five hours a day over two days. This course was developed with Australia’s eminent keyboard trainer, Ron Lawrence, who taught thousands of people before he started offering these very popular intensive courses.

You can use this plan in several ways. You may want to learn very quickly over two consecutive days. You may only have time to learn on the weekend – you can use this plan to learn over say two Saturdays in a row. People who want to learn in a more relaxed schedule can follow the same activities over a ten-day period.

All paths lead to ten-finger typing, some faster than others. It is not a race with winners or losers. It is about acquiring a skill and feeling great about reaching personal goals.

Your success is YOUR OWN! You are not competing with anybody; there is no pass or fail mark. Relax and enjoy the learning experience.

Remember, the intensive two-day plan will not suit everyone. You must be very focused and determined to reach your goal.

There are scheduled breaks in the plan. It is important that you take these breaks and refresh yourself. It will help your concentration and ability to learn. Take a walk outside, have lunch, have a tea or coffee break – whatever you do, time out will help. If your hands feel sore or your muscles fatigued, you should stop and stretch.

When you have relaxed for a few minutes you should do 5 minutes of mental practice. Mental practice consists of sitting with your hands on your thighs, saying a letter, moving the finger correctly and ‘seeing’ the letter appear on the screen. Do this repeatedly for each letter you have learned.

Before Starting

The week before

You should set a goal for each day. Write down these goals and pin it up where you will see it often. You should also write down the reasons why you want to learn to type properly, for example:

"On the first day I will learn to type 20 letters without looking at the keys."

"I will start Day 2 and finish with a speed of 20 to 25 words per minute."

Tell your friends and family of your plan. They will follow your progress with interest and provide necessary support and encouragement.

Make the commitment and allocate your chosen two days in your diary.

Buy some glucose sweets. Glucose (in small doses) improves memory by up to 30%.

Imagine yourself touch typing competently, with your fingers moving effortlessly over the keyboard. Keep this vision alive.

On the day

Sit down and ensure your posture is correct in every detail. Adjust your chair and table. Make sure the light is good without screen reflections.

Get rid of any negative thoughts before you begin. This course is guaranteed to teach you to type with ten fingers. Adopt a positive attitude and you will succeed.

Remember these points throughout the course

You will see your speed and accuracy drop as you progress through lessons 1 to 6. Don’t worry, as this is normal owing to the increasing combinations of letters in the text.

If you find you are not making progress check the following:

- Keep your hands on the home row keys and return to the home row after pressing a key.
- Don’t be afraid of making a mistake.
- Do not look at your fingers when you type. Let your fingers find the keys. They are building up their own muscle memory.
- Adopt the correct posture.
Don't get overtired and exhausted.
Do not try to analyse what you are doing. Just go with the flow.

If your performance or attention wains, you should stop, relax and re-focus on your goals. Do some mental practice for 5 minutes. Recall a TYPEQUICK lesson you completed successfully.
Do some mental exercises every day, morning and evening.
Work towards increasing your speed goals of 15, 20, 25 and 30. You will reach these speeds over the coming months.

The Plan

At the start of each day:
- Eat a glucose sweet.
- Turn off the phone.
- Put on some music of your choice – preferably something relaxing.

Achieve the right mind set:
- Recall some positive experiences.
- Visualise yourself typing with ten fingers.
- Believe that you are successful.

Relax the mind and body:
- Progressively relax muscles from your scalp to your toes.
- Breathe slowly and deeply while you imagine a peaceful scene.

Then follow the schedule on the next page.

---

**After you learn to touch type promise yourself that you will NOT go back to your old bad habits or look down at the keys again. Keep typing every day - either your own work or the TYPEQUICK exercises.**

---

### THE TYPEQUICK 2 Day Plan

#### DAY 1

<table>
<thead>
<tr>
<th>Start</th>
<th>Finish</th>
<th>Action</th>
<th>Lesson</th>
</tr>
</thead>
<tbody>
<tr>
<td>9am</td>
<td>9.30</td>
<td>Read the manual up to Lesson 4</td>
<td>8.45</td>
</tr>
<tr>
<td>9.30</td>
<td>10.30</td>
<td>Learning and practice</td>
<td>9.00</td>
</tr>
<tr>
<td>10.30</td>
<td>10.45</td>
<td>Load the course</td>
<td>10.15</td>
</tr>
<tr>
<td>10.45</td>
<td>11.45</td>
<td>Learning e1h</td>
<td>11.45</td>
</tr>
<tr>
<td>11.45</td>
<td>12.00</td>
<td>Stretch, exercise &amp; relax</td>
<td>12.00</td>
</tr>
<tr>
<td>12.00</td>
<td>1.00</td>
<td>Learning two R Shift</td>
<td>1.00</td>
</tr>
<tr>
<td>1.00</td>
<td>1.30</td>
<td>Lunch</td>
<td>1.30</td>
</tr>
<tr>
<td>1.30</td>
<td>2.00</td>
<td>Learning 3R Shift</td>
<td>2.00</td>
</tr>
<tr>
<td>2.00</td>
<td>2.15</td>
<td>Stretch, exercise &amp; relax</td>
<td>2.15</td>
</tr>
<tr>
<td>2.15</td>
<td>2.45</td>
<td>Learning 4R Shift</td>
<td>2.45</td>
</tr>
<tr>
<td>2.45</td>
<td>3.00</td>
<td>Stretch, exercise &amp; relax</td>
<td>3.00</td>
</tr>
<tr>
<td>3.00</td>
<td>4.00</td>
<td>Consolidating</td>
<td>4.00</td>
</tr>
</tbody>
</table>

#### DAY 2

<table>
<thead>
<tr>
<th>Start</th>
<th>Finish</th>
<th>Action</th>
<th>Lesson</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.30</td>
<td>4.00</td>
<td>Learning 4R Shift</td>
<td>3.30</td>
</tr>
<tr>
<td>4.00</td>
<td>4.20</td>
<td>Stretch, exercise &amp; relax</td>
<td>4.20</td>
</tr>
<tr>
<td>4.20</td>
<td>4.45</td>
<td>Learning 4R Shift</td>
<td>4.45</td>
</tr>
<tr>
<td>4.45</td>
<td>5.15</td>
<td>Stretch, exercise &amp; relax</td>
<td>5.15</td>
</tr>
<tr>
<td>5.15</td>
<td>5.50</td>
<td>Advanced menu exercises</td>
<td>5.50</td>
</tr>
</tbody>
</table>

**Congratulations! You're halfway there already.**

---

Copyright © 2010 Typequick Pty Limited
Welcome to the Adventure

Hey there, I’m Kewala as in Key…wala.

I’m going to be your travelling partner for this amazing typing journey to the… (Drumroll)… Kingdom of Eaz.

You can’t even begin to imagine the adventures we’ll share. I wish I’d had a travelling partner when I learned to type – no-one believed any of my experiences. Not to mention that it would’ve been fun learning with someone else. At least this time we can cruise up croc-infested rivers together, and bags you try any weird foods before me – it was impossible to convince anyone that I only liked gum leaves, so I had to eat a witchetty grub with this goanna one day, and Bogong Moths while travelling at night to Rainbow Beach – totally gross!

Nah, most of it’ll be really cool – we get to ride different animals over the ten wickedest routes in Australia. We can travel under the stars through the middle of the desert, and on the way collect enough magic keystones to build a keyboard. Not bad, eh? And, just to top it off, if we manage to find all the keystones, we’ll get to meet Wise Fella, who lives in the Kingdom of Eaz – and I’m not even going to bother telling you about that place – it’s just way too cool.

Let’s get moving!

Kewala

TYPEQUICK for Students now features a Mouse Course. This course has been designed to familiarise users new to computers with all the mouse functions. There is so much more to the mouse than a simple click. Students will learn how to double click and right click the mouse, how to drag and drop objects and how to effectively use the scroll wheel.
Main Menu

Each time you log in to TYPEQUICK, you will be taken to the Main Menu.

The following is a brief description of each of the Main Menu options:

Start or Resume Course: Takes you to your next lesson, continuing on from where you left off. If you are starting a course, this takes you to the first lesson.

Choose Lesson: Lets you choose a lesson to repeat or go to.

Choose Course: Lets you choose a course. The default for the initial course is Finding the Keys.

Progress Reports: Provides reports on lessons already completed for the course that is selected.

Settings: Lets you change settings such as target speed, font size, foreground and background colours.

Logout: Logs the current student out of TYPEQUICK.

Exit: Exits and closes TYPEQUICK. This option is only available in the stand-alone version of the product.

Starting and Stopping Typequick

For details please read the information on pages 11 to 23.

Progress Reports

Once you have completed at least one lesson in the currently selected course, you can view a Progress Report at any time throughout the course. There are two parts to the Progress Reports: the Analysis and the Key Report.

To view Progress Reports, click the Progress Reports option on the Main Menu (or select Progress Reports from the File menu).

Analysis report

The Analysis report shows each lesson and lesson part completed.

The report default ranking is by Lesson from the last lesson completed to the first. To change the way the report is sorted, click on the header of the column you wish to rank by, for example to rank by words per minute click on WPM.

The number 1 and a red arrow will appear in the header. The report is now ranking by words per minute, from highest to lowest.
To sort a column from lowest to highest, click again on the header row and the arrow will change to point upwards ▲ and the sort order will change.

**Changing the Column Selection and Column Sorting**
When you right click over a column heading, a pop-up menu displays. You can use the **Column Sorting** to sort the information in the Analysis Report by more than one column or the **Column Selection** to select which columns you want visible.

When you exit, any changes you made to the **Column Sorting** or **Column Selection** for the Progress Reports are saved.

**Key Report**
The **Key Report** analyses your speed and accuracy for each key and compares it to your goal. This shows the results for the lesson part you last completed in the currently selected course. It is a great way to see which lessons you may need to repeat. Any keys covered in other lessons you have completed are also included and the last results are shown.

From the **Analysis** click the **Key Report** option.

The **Speed** and **Error %** for each of the keys are shown as bars in the chart. The **Goal Speed** and **Average Speed** are shown as lines. The Goal is taken from the Target Speed in the Settings for the course. This can be changed using the **Settings** option.

**Closing the Reports**
To close the reports, select the **Close Reports** option from the **Lesson** menu.
**Settings**

There are various settings used to change features such as target speed, size of fonts, colours, audio preferences, whether one or two spaces are used after a full stop or period and the type of keyboard being used. The default settings should be suitable for most students. Some students may wish to change various settings to suit their viewing preferences. Advanced students can alter their target speed, or for students with special needs such as the visually impaired, the default colour selections, font and font size can be changed.

*Note:* Most Settings options only relate to a specific course.

To change the settings, click the **Settings** option on the Main Menu (or select **Settings** from the **File** menu).

There are various tabs that are used to configure different aspects of a course. Click on the appropriate tab in the dialog box to display that tabbed screen.

You can change the settings while a lesson is running, but you will not be able to change the selection for the keyboard or keypad in the **Input Device**. While a lesson is running, the **Input Device** tab is not displayed.

**Using the Menus**

You can perform most common actions from the **File** and **Lesson** menus at the top of the screen. All of the options available from the Main Menu are also available from the **File** and **Lesson** menus.

**File Menu**

- **Proficiency Statement**
  - For the student that is currently logged in, this option prints a Proficiency Statement stating the student’s full name, whether all or parts of the course have been completed and speed in words per minute and percentage accuracy attained. Click the “Print” button to print this.

- **Add Licence**
  - Use this option to add a licence. If you have been using TYPEQUICK in Evaluation Mode or you have purchased additional licences you can add a licence key at anytime.

- **Synchronizing**
  - Use this option to synchronize a USB drive with a network server.

- **Import Student Data**
  - Use this option to import the student data file that has been saved using the Export Student Data option (see below).

- **Export Student Data**
  - Saves a copy of your student data file in the location of your choice. This exports your student information, results of the lessons you have completed and preferences you have set up in the Settings.

- **Login**
  - Available at start up and when not logged in. The login dialog box is displayed. Click the “OK” button when the correct details have been entered. Remember, if you are using passwords these are case sensitive.

- **Logout**
  - When you have finished your lesson(s), but want to leave the program on your screen, you can log out by selecting **Logout**. This will allow you or someone else to log in and continue learning.
Exit

This option is only available in the stand-alone version of the product. It will shut the program down and you will need to restart TYPEQUICK before continuing.

Lesson Menu

Start or Resume Course

Takes you to your next lesson or lesson part. If you are starting a course for the first time you will be taken to the first lesson part of the course selected.

Stop Lesson

If you are in the middle of a lesson and wish to stop for any reason, you can do so by selecting Stop Lesson.

Choose Lesson

Lets you choose a lesson to repeat or go on to.

Choose Course

Lets you choose a course. The default course is Finding the Keys.

Settings

Lets you change settings such as target speed, foreground and background colours.

Progress Reports

Provides reports on lessons already completed.

Close Reports

Closes any open reports – only available when you have chosen the Progress Reports option.

Help Menu

Program Help

This option displays a Help file with information about the product and its features.

Typequick Website

Provided you are connected to the Internet, this displays the Typequick Website, located at www.typequick.com.au

About

Displays a dialog box with copyright, version information about the current product and credits.

Typequick for Students

Course Descriptions

The courses included in the Typequick for Students program are:

Finding the Keys (default)

This is the first part of the Adventure where you will master the keys. You will be typing quickly and properly by the time you reach the Kingdom of Eaz.

This course teaches correct finger positioning and associated keys of the alpha/numeric keyboard in ten structured lessons. This is the default course and is the recommended starting point.

Royal Challenge

This course will build your speed and accuracy. Wise Fella will give you challenges which will take Kewala into the wild to catch the ten finger speed master. This is only for you if you have found the Kingdom of Eaz or you can already type without looking at the keyboard.

The lesson parts in Royal Challenge alternate between improving your speed and improving your accuracy. The speed challenges are designed to help you reach your touch typing/keyboarding goal and will not stop you if you make a mistake. The accuracy challenges are designed to improve your accuracy and make you press the correct key to continue with the challenge.

Royal Challenge 2

This course is similar to Royal Challenge except the text is more formal.

Punctuation Course

Teaches the most commonly used punctuation keys.

Keypad Lessons

Teaches the numeric pad for data entry in three easy lessons.
The Planets

A series of quite long lessons providing practice in speed and accuracy. The text and images used cover a range of interesting information on the planets and moons in our solar system.

Australian Animals

A series of shorter lessons providing accuracy revision. The text and images describe popular and exotic Australian animals.

Metals

A series of shorter lessons providing accuracy revision. The text and images are related to five different commonly found metals.

The Senses

A series of shorter lessons providing accuracy revision. The text and images describe certain characteristics of the five primary senses of human beings.

Mouse Course

An introduction to the computer mouse. The course teaches all the basic functions of the mouse and terminology associated with it.

Guided Tour of the Journey

Kewala’s Adventure ends at the Kingdom of Eaz. To get there you need to complete the 3 courses: Finding the Keys, Royal Challenge and Royal Challenge 2. On your way to the Kingdom of Eaz you will travel with several fascinating characters across amazing scenes.

You will travel on the ten routes marked on Kewala’s map - each lesson in the course relates to a specific route. There are three places on each route where you will meet cool characters and find keystones. As you travel you will earn (and maybe lose) points.

Each key pressed, correct or incorrect, is recorded. Letters you experienced speed or accuracy weaknesses with are offered in remedial exercises.

A report is displayed at the end of every lesson part showing your speed and accuracy along with a message and your score.

There is also the option to do a Bonus Challenge. Press Yes to accept the challenge and earn bonus points.

By the time you reach the Kingdom of Eaz you will have collected all the keystones to build a keyboard and be able to touch type with ten fingers.

You will then be challenged by the Kings and Queens of the Kingdom to help you build your typing speed and accuracy during the Royal Challenges.

You and Kewala begin your adventure in the Great Sandy Desert bound for Uluru. The map will show you where you’ve been and where you’re going.
Keyboard Adventure Map

Colour in your journey as you go around Australia.

Finding the Keys

This is the default course. It is recommended that you start with this course and build your skills from here.

There are ten keyboard lessons. The first six lessons teach the letters of the alphabet in upper and lower case. When you find a keystone in the adventure, finger placement exercises introduce the new keys. Illustrations and simulations on your computer screen show the correct finger usage for each key. Specially designed exercises follow using only the keys you have learnt to that point.

Lessons 7 and 8 teach you how to use the number keys situated on the top row of the keyboard.

Lessons 9 and 10 aim to build speed and accuracy.

Each lesson is made up of three parts. Parts A and B teach new letters and combine them with the home keys and previously learnt letters. Part C is a consolidation lesson where all letters learnt so far are combined and presented in sentences and sometimes in longer paragraphs. These exercises are designed to build your skill level and confidence. You will be given a progress report at the end of each lesson part. Each key pressed, correct or incorrect, is recorded. Letters you experienced speed or accuracy weaknesses with are offered in remedial exercises.

Lesson Summary (Introduction - Lesson 1)

<table>
<thead>
<tr>
<th>LESSON</th>
<th>PART</th>
<th>KEYS LEARNT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td></td>
<td>Wise Fella</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Home Keys</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Posture Information</td>
</tr>
<tr>
<td>Lesson 1</td>
<td>Part A</td>
<td>asdf</td>
</tr>
<tr>
<td></td>
<td>Part B</td>
<td>jkl;</td>
</tr>
<tr>
<td></td>
<td>Consolidation</td>
<td>Exercises using all the keys learnt in this lesson. This is the start of your adventure - and what better place to start than riding on an emu in the desert.</td>
</tr>
</tbody>
</table>
### Lesson Summary (Lesson 2 - 5)

<table>
<thead>
<tr>
<th>LESSON</th>
<th>PART</th>
<th>KEYS LEARNT</th>
<th>Consolidation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lesson 2</td>
<td>Part A</td>
<td>ehi.</td>
<td>Exercices using all the keys learnt in this and prior lessons. Ride a toad down the river.</td>
</tr>
<tr>
<td></td>
<td>Part B</td>
<td>LJKHI</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Consolidation</td>
<td></td>
</tr>
<tr>
<td>Lesson 3</td>
<td>Part A</td>
<td>trno</td>
<td>Exercices using all the keys learnt in this and prior lessons. Type real words while sitting on a killer whale.</td>
</tr>
<tr>
<td></td>
<td>Part B</td>
<td>NO</td>
<td></td>
</tr>
<tr>
<td>Lesson 4</td>
<td>Part A</td>
<td>cuDETASFCU</td>
<td>Exercices using all the keys learnt in this and prior lessons. Capture the flying keystones on the back of a moth.</td>
</tr>
<tr>
<td></td>
<td>Part B</td>
<td>vwVWR</td>
<td></td>
</tr>
<tr>
<td>Lesson 5</td>
<td>Part A</td>
<td>gG</td>
<td>Exercices using all the keys learnt in this and prior lessons. Travel under the sea with a lantern fish. An enjoyable lesson with more plain English text than before.</td>
</tr>
<tr>
<td></td>
<td>Part B</td>
<td>xXpP</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Consolidation</td>
<td></td>
</tr>
</tbody>
</table>

### Lesson Summary (Lesson 6 - 8)

<table>
<thead>
<tr>
<th>LESSON</th>
<th>PART</th>
<th>KEYS LEARNT</th>
<th>Consolidation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lesson 6</td>
<td>Part A</td>
<td>qQmM</td>
<td>Exercices using all the keys learnt in this and prior lessons. Climb mountains on the back of a goat to find the last alphabetical keystones.</td>
</tr>
<tr>
<td></td>
<td>Part B</td>
<td>yYzZbB</td>
<td></td>
</tr>
<tr>
<td>Lesson 7</td>
<td>Part A</td>
<td>12</td>
<td>Exercices using all the keys learnt in this and prior lessons. Chase the number keystones along the highway riding your hog.</td>
</tr>
<tr>
<td></td>
<td>Part B</td>
<td>345</td>
<td></td>
</tr>
<tr>
<td>Lesson 8</td>
<td>Part A</td>
<td>67</td>
<td>Exercices using all the keys learnt in this and prior lessons. Ride a lizard deep underground and through caves to find the last keystones. This is the last creature you ride on the way to the Kingdom of Eaz. By the end you will know where all the numbers and letters are on the keyboard.</td>
</tr>
<tr>
<td></td>
<td>Part B</td>
<td>890</td>
<td></td>
</tr>
</tbody>
</table>
Lesson Summary (Lesson 9 - 10)

<table>
<thead>
<tr>
<th>LESSON</th>
<th>PART</th>
<th>KEYS LEARNED</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lesson 9</td>
<td>There are 3 exercises in this lesson</td>
<td>Building Accuracy, Building Speed</td>
</tr>
<tr>
<td></td>
<td>Building Accuracy will improve your accuracy. The program will stop at every mistake until you press the correct key.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>In Building Speed, type as fast as you can. The program will not stop if you make a mistake. Do not worry; you are building up your speed.</td>
<td></td>
</tr>
<tr>
<td>Lesson 10</td>
<td>There are 3 exercises in this lesson</td>
<td>Building Speed, Building Accuracy</td>
</tr>
<tr>
<td></td>
<td>Beat the white water to get to the Kingdom of Eaz.</td>
<td></td>
</tr>
</tbody>
</table>

Scoring

When doing a lesson you will see your score in the bottom right-hand side of the screen. There are many ways to earn points.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Each time you find a keystone you earn points.</td>
<td>1,000 points</td>
</tr>
<tr>
<td>Catch lazy prey and earn points.</td>
<td>500 points</td>
</tr>
<tr>
<td>Catch crafty prey, which can run away from you and earn big points. Type each word 10% faster.</td>
<td>1,000 points</td>
</tr>
<tr>
<td>Predator chases you. You lose points if you get caught. Start typing quicker when you hear the predator music. Speedy typing is needed here!</td>
<td>Minus 1,000 points</td>
</tr>
<tr>
<td>Victory flag in Bonus Challenge. You've got to type a bit faster than you did in the lesson to get these points.</td>
<td>500 - 1,000 points</td>
</tr>
<tr>
<td>500</td>
<td>Finish the bonus stage and get a quick bonus. 500 points</td>
</tr>
<tr>
<td>Same day</td>
<td>Doing another lesson part on the same day. You could do two sessions on the same day or do more than two parts in the same session. 2,000 points</td>
</tr>
</tbody>
</table>
Royal Challenges

This is where you get to show off your typing skills to just about every creature native to Australia. These challenges are only for people who can type with 10 fingers without looking at the keyboard. If you can’t touch type properly, revise the Finding the Keys course.

Lessons alternate between building speed and building accuracy. The speed challenges build speed without stopping you to correct mistakes. Just relax and let those fingers go. Be sure to type the letters above the red marker. The accuracy challenges will improve your accuracy. Try to maintain the same flowing speed you had in the speed challenges. You need to stop and correct any mistakes you make, so your accuracy results will be better than in speed challenges.

Soon you’ll be typing without even thinking about the key under your finger. The process is similar to that of learning to read, you may have spoken every letter and now you recognise whole words and phrases instead. Strive towards this connection between words in your mind and what your fingers type. Stop saying the letters to yourself, say only the words and they will appear on the screen. Good touch typists actually read one or two words ahead of the word they are typing.

This skill takes a bit of practise but once you have gained this automatic skill your speed will increase beyond your wildest dreams!

Punctuation Course

There are three lessons in this course that teach the most commonly used punctuation keys. You are given finger placement lessons followed by text exercises that combine words with the punctuation keys you have learnt.

Keypad Lessons

This course will teach you the correct use of the number keypad in three lessons. Correct use of the keypad equals rapid data entry of numbers.

Before you start, activate your computer keypad according to your computer manual - this may require the NUM LOCK key to be pressed. Using the Settings options and the Input Device tab, select the keypad layout that matches your computer keyboard.

The lessons use the standard data entry procedure of pressing the ENTER or TAB key after each number entry.

Place your right hand over the keypad with your first, second and third fingers over the home keys 4, 5 and 6. You may feel a raised dot on the 5 key.
The Planets Course

This course provides a great deal of text to help the student continue enhancing keyboarding expertise. The text covers a range of interesting facts about the planets and moons in our solar system. Visual material used as a backdrop to the text is drawn from the NASA/JPL web-sites.

Lessons alternate between speed mode (the cursor will continue to the next key even if the student makes mistakes) and accuracy mode (the cursor stops till the student presses the correct key).

<table>
<thead>
<tr>
<th>LESSON</th>
<th>PART</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lesson 1</td>
<td>Mercury</td>
</tr>
<tr>
<td>Lesson 2</td>
<td>Venus</td>
</tr>
<tr>
<td>Lesson 3</td>
<td>Earth</td>
</tr>
<tr>
<td>Lesson 4</td>
<td>Mars</td>
</tr>
<tr>
<td>Lesson 5</td>
<td>Jupiter</td>
</tr>
<tr>
<td>Lesson 6</td>
<td>Saturn</td>
</tr>
<tr>
<td>Lesson 7</td>
<td>Uranus</td>
</tr>
<tr>
<td>Lesson 8</td>
<td>Neptune</td>
</tr>
<tr>
<td>Lesson 9</td>
<td>The Dwarf Planets</td>
</tr>
</tbody>
</table>

Metals Course

More keyboard revision tests, this time with text based on information about five different metals. All lessons are in accuracy mode.

<table>
<thead>
<tr>
<th>LESSON</th>
<th>PART</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lesson 1</td>
<td>Gold</td>
</tr>
<tr>
<td>Lesson 2</td>
<td>Silver</td>
</tr>
<tr>
<td>Lesson 3</td>
<td>Copper</td>
</tr>
<tr>
<td>Lesson 4</td>
<td>Aluminium</td>
</tr>
<tr>
<td>Lesson 5</td>
<td>Mercury</td>
</tr>
</tbody>
</table>

The Senses Course

Five lessons with content created from descriptions of the senses. Accuracy mode is used in all the lessons.

<table>
<thead>
<tr>
<th>LESSON</th>
<th>PART</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lesson 1</td>
<td>Sight</td>
</tr>
<tr>
<td>Lesson 2</td>
<td>Hearing</td>
</tr>
<tr>
<td>Lesson 3</td>
<td>Smell</td>
</tr>
<tr>
<td>Lesson 4</td>
<td>Taste</td>
</tr>
<tr>
<td>Lesson 5</td>
<td>Touch</td>
</tr>
</tbody>
</table>

Australian Animals Course

A short series of keyboard revision texts. The content covers information about five common Australian animals along with images of them. All lessons are set for accuracy mode.

<table>
<thead>
<tr>
<th>LESSON</th>
<th>PART</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lesson 1</td>
<td>Wombat</td>
</tr>
<tr>
<td>Lesson 2</td>
<td>Koala</td>
</tr>
<tr>
<td>Lesson 3</td>
<td>Platypus</td>
</tr>
<tr>
<td>Lesson 4</td>
<td>Kangaroo</td>
</tr>
<tr>
<td>Lesson 5</td>
<td>Emu</td>
</tr>
</tbody>
</table>
Mouse Course Description

The mouse course is designed to introduce the student to all the basic functions of the mouse.

Emphasis is placed on teaching the actions that are possible with a mouse (includes clicking, double clicking and dragging). Students are taught that actions may have different results in different contexts.

Terminology associated with mice is also covered.

The course has little on-screen text, relying on a mix of images and spoken messages to cover the course content and give instructions to the student.

<table>
<thead>
<tr>
<th>LESSON</th>
<th>PART</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lesson 1</td>
<td>Introduction</td>
<td>The Mouse and its parts</td>
</tr>
<tr>
<td>Lesson 2</td>
<td>What Can I Do With My Mouse</td>
<td>Ways in which the mouse can be used</td>
</tr>
<tr>
<td>Lesson 3</td>
<td>How to Use a Mouse</td>
<td>Directing the mouse to specific places on screen</td>
</tr>
<tr>
<td>Lesson 4</td>
<td>Single Click</td>
<td>Find images and click on them</td>
</tr>
<tr>
<td>Lesson 5</td>
<td>Double Click</td>
<td>Find images and double-click on them</td>
</tr>
<tr>
<td>Lesson 6</td>
<td>Click and Drag</td>
<td>Complete a jig-saw puzzle by click and drag</td>
</tr>
<tr>
<td>Lesson 7</td>
<td>Right Click</td>
<td>Explore program behaviour with right click</td>
</tr>
<tr>
<td>Lesson 8</td>
<td>Scroll Bars</td>
<td>Learn scroll bar parts and functions</td>
</tr>
<tr>
<td>Lesson 9</td>
<td>The Scroll Wheel</td>
<td>Learn how to use the scroll wheel</td>
</tr>
</tbody>
</table>

How to do the Lessons

The following explains the general features of Typequick for Students and what information is displayed on the screen when doing a lesson.

Information Line

The information line at the bottom of the screen gives instructions on what to do or information on what Typequick for Students is doing.
Copy the Line Presented

When you are asked to copy the line presented, type the same letter below the displayed letter. The red arrow marker shows you what you should be typing. Press the Spacebar when there is a space in the text.

Finding a Keystone

When you find a keystone in the adventure, a screen appears with a picture of two hands. You are shown the position of that key in relation to the other keys on the keyboard. You are also shown the correct finger positioning with simulated hands over the keyboard. This helps ensure that you use the correct fingers while learning.

Timeout

If you are expected to press a particular key and you fail to press any key for more than FIVE seconds, a timeout message displays when copying lines. This message will tell you to press the correct key, for example "TIMEOUT, press the 'a' key". While the Timeout message is displayed time is not taken into account for purposes of calculating your speed in words per minute (or keys per minute).

Note: The timer will not start until you enter the first letter at the beginning of the line. This gives you a chance to take a break if you need to.

Mini Keyboard

For some lessons, a mini keyboard sits at the bottom of your screen showing the keys you are learning.

If you are expected to press a particular letter and you press an incorrect one, or you fail to press any key, the correct key will flash on the mini keyboard.

If you see an error message when you think you have pressed the correct key, ensure the Caps Lock function is not on. If it is on, the letters will be typed as capital letters instead of lower-case letters.
**Bonus Challenge**

At the end of each part in lessons 1 to 10, you will be offered a bonus challenge and you will see the following message. Press the “Yes” button to accept the challenge and earn bonus points. You gain points for each flag you reach before your opponent, and points for completing the challenge.

![Extension Exercises](image)

**Lesson Part Results**

At the end of each lesson part and Bonus Challenge you are shown your speed and accuracy results for that lesson part.

At the bottom of the screen there are three options: **Analysis**, **Continue** and **Stop**.

- Click **Analysis** to display the Key Report for that lesson part. This shows an analysis of the results of each key for the lesson part you have just completed. This is in the same format as the Key Report displayed when you select the **Progress Reports** option.
- Click **Continue** to go to the next lesson or lesson part. If relevant you will be prompted, “Do you want to do an extension exercise?” You can click “Yes” for additional practice, or click “No” to continue with the next lesson part.
- Click **Stop** to redisplay the Main Menu.

**Repeating a Lesson**

You can repeat a lesson at any time. Just click the **Choose Lesson** option on the Main Menu (or select **Choose Lesson** from the **File** menu) and choose the lesson or lesson part you wish to repeat. When you repeat the lesson, the results are recorded as the latest results for that lesson.

The third time you repeat a lesson you will be taken directly to the copy typing exercises. You will not be shown the finger positioning simulation.

**Stopping a Lesson**

If you need to, you can stop a lesson without having completed it by selecting **Stop Lesson** from the **File** menu. No results are saved for that lesson part and you will be asked to repeat it when you next resume the course.

**Speed or Accuracy Exercises**

When you are doing an exercise that checks accuracy, the program does not allow you to continue unless you press the correct key. You will always be prompted which key to press, but you cannot race ahead of the program.

As the speed exercises are designed to help build your speed, don’t get caught up in the accuracy of what you are typing. When doing a speed exercise the program allows you to carry on regardless of the mistakes you make. The errors are shown in red and you are able to go back and correct them before moving onto the next line, but the aim here is speed, so ignore all errors and go for it!

Refer also to **Course Descriptions** for details of these courses.
Esc key to Cancel Animations or Stop a Lesson

You can cancel certain animations by pressing the Esc key on the keyboard. This will skip that part of the lesson and move on to the next part. If you press the Esc key when animations are not running, this will end the lesson and, if relevant, you will be prompted to confirm that you want to end it. This is the same as selecting the Stop Lesson option (see above). If you end a lesson part before completing it, no results will be saved and when you next resume the course you will be asked to repeat that lesson part.

Resizing the TYPEQUICK Window

You can drag the edges of the TYPEQUICK window to resize it. When you exit the course and restart TYPEQUICK, your screen redisplay at the size it was last set.

Introduction to TYPEQUICK

Welcome to TYPEQUICK

We all use computers and other electronic devices extensively for work, personal communication and organising our lives, storing information and data. The keyboard remains the primary interface with computers and most electronic devices yet very few people have effective basic keyboard skills. Users get by using two or three fingers and by looking at the keyboard searching for the correct key. Many people feel that this is “good enough” and get the job done. No matter that they are slow or make many mistakes that have to be corrected later or worse still send out emails or presentations containing typing errors or poor formatting.

Congratulations on deciding to buy Typequick and making the commitment to learn how to touch type with ten fingers. If you complete the course you will gain a valuable life long skill that will set you apart. You will be able to type without looking at the keyboard, you will have the luxury of thinking of what you want to communicate rather than be hunting for the next key and you will produce professional work. You will learn correct posture while at the keyboard which will prevent discomfort, aches and pains. But best of all you’ll free up valuable time to spend as you choose.

TYPEQUICK has been teaching people aged from 8 to 80 years to touch type for over 25 years. We have built strong relationships with experts in education who give us constant feedback and advice. This feedback is used to continually develop TYPEQUICK so that it is always current, user friendly and highly functional.

Using the guaranteed, quick and easy TYPEQUICK method you will:

- Gain correct touch-typing skills
- Learn to type accurately and confidently at speed
- Gain more time – less time spent on producing documents means more time for you
- Significantly increase productivity and decrease your level of frustration
- Gain a competitive advantage and a life-long skill
Main Menu

Each time you log in to TYPEQUICK, you will be taken to the Main Menu.

The following is a brief description of each of the Main Menu options:

Start or Resume Course Takes you to your next lesson, continuing on from where you left off. If you are starting a course, this takes you to the first lesson.

Choose Lesson Lets you choose a lesson to repeat or go to.

Choose Course Lets you choose a course. The default for the initial course is Keyboard Lessons.

Progress Reports Provides reports on lessons already completed for the course that is selected.

Settings Lets you change settings such as target speed, font size, foreground and background colours.

Logout Logs the current student out of TYPEQUICK.

Exit Exits and closes TYPEQUICK. This option is only available in the stand-alone version of the product.

Starting and Stopping Typequick

For details please read the information on pages 11 to 23.

Progress Reports

Once you have completed at least one lesson in the currently selected course, you can view a Progress Report at any time throughout the course. There are two parts to the Progress Reports: the Analysis and the Key Report.

To view Progress Reports, click the Progress Reports option on the Main Menu (or select Progress Reports from the File menu).

Analysis report

The Analysis report shows each lesson and lesson part completed.

The report default ranking is by Lesson from the last lesson completed to the first. To change the way the report is sorted, click on the header of the column you wish to rank by, for example to rank by words per minute click on WPM.

The number 1 and a red arrow ▼ will appear in the header. The report is now ranking by words per minute, from highest to lowest.
To sort a column from lowest to highest, click again on the header row and the arrow will change to point upwards ▲ and the sort order will change.

**Changing the Column Selection and Column Sorting**
When you right click over a column heading, a pop-up menu displays. You can use the Column Sorting to sort the information in the Analysis Report by more than one column or the Column Selection to select which columns you want visible.

When you exit, any changes you made to the Column Sorting or Column Selection for the Progress Reports are saved.

---

**Key Report**

The Key Report analyses your speed and accuracy for each key and compares it to your goal. This shows the results for the lesson part you last completed in the currently selected course. It is a great way to see which lessons you may need to repeat. Any keys covered in other lessons you have completed are also included and the last results are shown.

From the Analysis click the **Key Report** option.

The Speed and Error % for each of the keys are shown as bars in the chart. The Goal Speed and the Average Speed are shown as lines. The Goal is taken from the Target Speed in the Settings for the course. This can be changed using the Settings option.

**Closing the Reports**
To close the reports, select the Close Reports option from the Lesson menu.
**Settings**

There are various settings used to change features such as target speed, size of fonts, colours, audio preferences, whether one or two spaces are used after a full stop or period and the type of keyboard being used. The default settings should be suitable for most students. Some students may wish to change various settings to suit their viewing preferences. Advanced students can alter their target speed, or for students with special needs such as the visually impaired the default colour selections, font and font size can be changed.

*Note:* Most Settings options only relate to a specific course.

To change the settings, click the **Settings** option on the Main Menu (or select **Settings** from the **File** menu).

There are various tabs that are used to configure different aspects of a course. Click on the appropriate tab in the dialog box to display that tabbed screen.

You can change the settings while a lesson is running, but you will not be able to change the selection for the keyboard or keypad in the **Input Device**. While a lesson is running, the **Input Device** tab is not displayed.

**Using the Menus**

You can perform most common actions from the **File** and **Lesson** menus at the top of the screen. All of the options available from the Main Menu are also available from the **File** and **Lesson** menus.

**File Menu**

- **Proficiency Statement**
  
  For the student that is currently logged in, this option prints a **Proficiency Statement** stating the student’s full name, whether all or parts of the course have been completed and speed in words per minute and percentage accuracy attained. Click the “Print” button to print this.

- **Add Licence**
  
  Use this option to add a licence. If you have been using TYPEQUICK in Evaluation Mode or you have purchased additional licences you can add a licence key at anytime.

- **Synchronize**
  
  Use this option to synchronize a USB drive with a network server.

- **Import Student Data**
  
  Use this option to import the student data file that has been saved using the **Export Student Data** option (see below).

- **Export Student Data**
  
  Saves a copy of your student data file in the location of your choice. This exports your student information, results of the lessons you have completed and preferences you have set up in the Settings.

- **Login**
  
  Available at start up and when not logged in. The login dialog box is displayed. Click the "OK" button when the correct details have been entered. Remember, if you are using passwords these are case sensitive.

- **Logout**
  
  When you have finished your lesson(s), but want to leave the program on your screen, you can log out by selecting **Logout**. This will allow you or someone else to log in and continue learning.
The courses included in the Typequick Professional program are:

**Keyboard Lessons**
This course teaches the correct finger positioning and associated keys of the alphabetic/numeric keyboard in ten structured lessons. This is the default course and is the recommended starting point.

**Speed Challenge**
The speed challenge is designed to help you reach your touch-typing/keyboarding goal.

**Accuracy Challenge**
Doing this course, you will copy-type text that is designed to keep you interested while having to press the correct key to progress.

**Advanced Challenge**
You will copy-type text with the emphasis on building your speed.

**Punctuation Course**
Teaches the most commonly used punctuation keys.

**Keypad Lessons**
Teaches the number pad for data entry in three easy lessons.

---

**Exit**
This option is only available in the stand-alone version of the product. It will shut the program down and you will need to restart TYPEQUICK before continuing.

**Lesson Menu**
- **Start or Resume Course**
  Takes you to your next lesson or lesson part. If you are starting a course for the first time you will be taken to the first lesson part of the course selected.
- **Stop Lesson**
  If you are in the middle of a lesson and wish to stop for any reason, you can do so by selecting Stop Lesson.
- **Choose Lesson**
  Lets you choose a lesson to repeat or go on to.
- **Choose Course**
  Lets you choose a course. The default course is Keyboard Lessons.
- **Settings**
  Lets you change settings such as target speed, foreground and background colours.
- **Progress Reports**
  Provides reports on lessons already completed.
- **Close Reports**
  Closes any open reports – only available when you have chosen the Progress Reports option.

**Help Menu**
- **Program Help**
  This option displays a Help file with information about the product and its features.
- **Typequick Website**
  Provided you are connected to the Internet, this displays the Typequick Website, located at www.typequick.com.au
- **About**
  Displays a dialog box with copyright, version information about the current product and credits.

**TYPEQUICK Professional**

**Course Descriptions**

The courses included in the Typequick Professional program are:

**Keyboard Lessons**
This course teaches the correct finger positioning and associated keys of the alphabetic/numeric keyboard in ten structured lessons. This is the default course and is the recommended starting point.

**Speed Challenge**
The speed challenge is designed to help you reach your touch-typing/keyboarding goal.

**Accuracy Challenge**
Doing this course, you will copy-type text that is designed to keep you interested while having to press the correct key to progress.

**Advanced Challenge**
You will copy-type text with the emphasis on building your speed.

**Punctuation Course**
Teaches the most commonly used punctuation keys.

**Keypad Lessons**
Teaches the number pad for data entry in three easy lessons.

**Keyboard Lessons**
This is the default course. It is recommended that you start with this course and build your skills from here.

There are ten keyboard lessons. The first six lessons teach the letters of the alphabet in upper and lower case. Each one begins with finger placement exercises introducing the new keys. Illustrations and simulations on your computer screen show you the correct finger usage for each key. Specially designed exercises follow that use only the keys you have learnt to that point.
Lessons 7 and 8 teach you how to use the numeric keys situated on the top row of the keyboard.

Lessons 9 and 10 aim to build speed and accuracy.

Each lesson is made up of three parts. Parts A and B teach new letters and combine them with the home keys and previously learnt letters. Part C is a consolidation lesson where all letters learnt so far are combined and presented in sentences and sometimes in longer paragraphs. These exercises are designed to build your skill level and confidence. You will be given a progress report at the end of each lesson part.

Each key pressed, correct or incorrect, is recorded. Letters you experienced speed or accuracy weaknesses with are offered in remedial exercises.

Lesson Summary (Introduction - 3)

<table>
<thead>
<tr>
<th>LESSON</th>
<th>PART</th>
<th>KEYS LEARNT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td></td>
<td>Home Keys, Posture Information</td>
</tr>
<tr>
<td>Lesson 1</td>
<td>Part A</td>
<td>asdf</td>
</tr>
<tr>
<td></td>
<td>Part B</td>
<td>jkl;</td>
</tr>
<tr>
<td></td>
<td>Consolidation</td>
<td>Exercises using all of the keys learnt in this lesson.</td>
</tr>
<tr>
<td>Lesson 2</td>
<td>Part A</td>
<td>ehi.</td>
</tr>
<tr>
<td></td>
<td>Part B</td>
<td>LJKHI</td>
</tr>
<tr>
<td></td>
<td>Consolidation</td>
<td>Exercises using all of the keys learnt in this and prior lessons.</td>
</tr>
<tr>
<td>Lesson 3</td>
<td>Part A</td>
<td>trno</td>
</tr>
<tr>
<td></td>
<td>Part B</td>
<td>NO</td>
</tr>
<tr>
<td></td>
<td>Consolidation</td>
<td></td>
</tr>
</tbody>
</table>

Lesson Summary (4 - 10)

<table>
<thead>
<tr>
<th>LESSON</th>
<th>PART</th>
<th>KEYS LEARNT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lesson 4</td>
<td>Part A</td>
<td>cuDETAFCU</td>
</tr>
<tr>
<td></td>
<td>Part B</td>
<td>vwVWR</td>
</tr>
<tr>
<td></td>
<td>Consolidation</td>
<td></td>
</tr>
<tr>
<td>Lesson 5</td>
<td>Part A</td>
<td>.gG</td>
</tr>
<tr>
<td></td>
<td>Part B</td>
<td>.xXpP</td>
</tr>
<tr>
<td></td>
<td>Consolidation</td>
<td></td>
</tr>
<tr>
<td>Lesson 6</td>
<td>Part A</td>
<td>qQmM</td>
</tr>
<tr>
<td></td>
<td>Part B</td>
<td>.yYzZbB</td>
</tr>
<tr>
<td></td>
<td>Consolidation</td>
<td></td>
</tr>
<tr>
<td>Lesson 7</td>
<td>Part A</td>
<td>12</td>
</tr>
<tr>
<td></td>
<td>Part B</td>
<td>345</td>
</tr>
<tr>
<td></td>
<td>Consolidation</td>
<td></td>
</tr>
<tr>
<td>Lesson 8</td>
<td>Part A</td>
<td>67</td>
</tr>
<tr>
<td></td>
<td>Part B</td>
<td>890</td>
</tr>
<tr>
<td></td>
<td>Consolidation</td>
<td></td>
</tr>
<tr>
<td>Lesson 9</td>
<td>There are 3 exercises in this lesson</td>
<td>Building Accuracy</td>
</tr>
<tr>
<td></td>
<td>Building Speed</td>
<td></td>
</tr>
<tr>
<td>Lesson 10</td>
<td>There are 3 exercises in this lesson</td>
<td>Building Speed</td>
</tr>
<tr>
<td></td>
<td>Building Accuracy</td>
<td></td>
</tr>
</tbody>
</table>
How to do the Lessons

The following explains the general features of Typequick Professional and what information is displayed on the screen when doing a lesson.

Information Line

The information line at the bottom of the screen gives instructions on what to do or information on what Typequick Professional is doing.

Hands Showing Correct Finger Positioning

When each new key is taught, you are shown the position of that key in relation to the other keys on the keyboard. You are also shown the correct finger positioning with simulated hands over the keyboard. This helps ensure that you use the correct fingers while learning.

Mini Keyboard

For some lessons, a mini keyboard sits at the bottom of your screen showing the keys you are learning.

If you are expected to press a particular letter and you press an incorrect one, or you fail to press any key, the correct key will flash on the mini keyboard.

If you see an error message when you think you have pressed the correct key, ensure the Caps Lock function is not on. If it is on the letters will be typed as capital letters instead of lower-case letters.
Copy the Line Presented

When you are asked to copy the line presented, type the same letter below the displayed letter. The red arrow marker shows you what you should be typing. Press the Spacebar when there is a space in the text.

In some lessons, if you press the wrong key, you will see a message indicating the key you should press, for example, "Error, press the 'a' key". You have to press the correct key before you can continue. In the lessons that test for speed you will not be stopped if you make a mistake.

As well as combinations of keys, you will also be given words to practise. A record will be kept of words or combinations of keys that you may have had difficulties with during a lesson. These words or keys will be repeated or offered more frequently to give you additional practice.

Extension Lessons

When you have completed certain lessons you are given the option to do an extension lesson. This will give you additional practice. You cannot select these extension lessons from the Choose Lesson option. You can only access them after completing a lesson part.

Lesson Part Results

At the end of each lesson part and every extension lesson you are shown your speed and accuracy results for that lesson part.

At the bottom of the screen there are three options: Analysis, Continue and Stop.

- Click Analysis to display the Key Report for that lesson part. This shows an analysis of the results of each key for the lesson part you have just completed. This is in the same format as the Key Report displayed when you select the Progress Reports option.
- Click Continue to go to the next lesson or lesson part. If relevant you will be prompted, "Do you want to do an extension exercise?" You can click "Yes" for additional practice, or click "No" to continue with the next lesson part.
- Click Stop to redisplay the Main Menu.

Repeating a Lesson

You can repeat a lesson at any time. Just click the Choose Lesson option on the Main Menu (or select Choose Lesson from the File menu) and choose the lesson or lesson part you wish to repeat. When you repeat the lesson, the results are recorded as the latest results for that lesson.

The third time you repeat a lesson you will be taken directly to the copy typing exercises. You will not be shown the finger positioning simulation.
Stopping a Lesson

If you need to, you can stop a lesson without having completed it by selecting \texttt{Stop Lesson} from the \texttt{File} menu. No results are saved for that lesson part and you will be asked to repeat it when you next resume the course.

Speed or Accuracy Exercises

When you are doing an exercise that checks accuracy, the program does not allow you to progress unless you press the correct key. You will always be prompted which key to press, but you cannot race ahead of the program.

As the speed exercises are designed to help build your speed, don’t get caught up in the accuracy of what you are typing. When doing a speed exercise the program allows you to carry on regardless of the mistakes you make. The errors are shown in red and you are able to go back and correct them before moving onto the next line, but the aim here is speed, so ignore all errors and go for it!

Refer also to \texttt{Course Descriptions} for details of these courses.

Esc key to Cancel Animations or Stop a Lesson

You can cancel certain animations by pressing the Esc key on the keyboard. This will skip that part of the lesson and move on to the next part. If you press the Esc key when animations are not running, this will end the lesson and, if relevant, you will be prompted to confirm that you want to end it. This is the same as selecting the \texttt{Stop Lesson} option (see above). If you end a lesson part before completing it, no results will be saved and when you next resume the course you will be asked to repeat that lesson part.

Resizing the TYPEQUICK Window

You can drag the edges of the TYPEQUICK window to resize it. When you exit the course and restart TYPEQUICK, your screen rediscovers at the size it was last set.